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With Motion 5, Apple has added some great new features - and taken a few away. In this 2-part article, I explain what I consider to be the top 5 new features and the top 5 missing features of this exciting new release.
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Motion 5:   Top 5 New Features
June 22, 2011     By Mark Spencer
 
1 The Interface
The new Motion 5 has arrived - and here's the funny thing: while it looks radically different, contains features that represent a completely new paradigm, and will change the way motion graphics are created - it is at the same time no different at all. How can that be? Read on for summary of what I consider the 5 biggest changes in Motion 5, and why they change everything - and nothing at all.
The most obvious change is the user interface. Folks familiar with Motion 4 and earlier will be struck immediately by Motion's 5 sleek, dark look: it's beautiful, easy on the eyes, and complements Final Cut Pro X's interface perfectly.
[image: motion_5_new_features_spencer_01b.png]
The Motion 5 Interface.
Instead of two separate windows - a Utility Pane and a Canvas - found in Motion 4 and earlier, Motion 5 sports a single unified interface, just like Final Cut Pro X.
The components of the interface, however, really haven't changed. The File Browser, Library, and Inspector can still be found in the left column; the Project Pane next to the Canvas still contains Layers, Media, and Audio - although these "tabs" are now referred to as "lists" - as in, "select the Layers List."
[image: motion_5_new_features_spencer_02b.jpg]
The Layers List.
The toolbar has been moved - it used to live above the Canvas but has been moved down below it - providing quicker, easier access.
Below the Toolbar is the Timing pane, just like prior versions. However it is now opened by default - and the Keyframe Editor and the Audio Timeline no longer have their own tabs. They do, however, have buttons in the lower right corner, as well as keyboard shortcuts - and can be accessed from the Window menu. Since the Timeline is the primary tool, here that makes sense to me - in fact, I would have done the same with the Audio and Media lists in the Project Pane.
Many icons have received an overhaul, and there are several other tweaks throughout the interface that you'll discover as you work with Motion 5, but if you've used Motion 4, 3, or even 2, once you get over the initial shock of the darker shade, you'll feel right at home.
Everything else in Motion is mostly unchanged - all the Library elements - behaviors, filters, shapes, generators, emitters, replicators, etc. are intact and work the same way. The way you work with 3D in Motion 4 - reflections, lights, shadows, animating cameras in 3D space - all work as they have previously.
[image: motion_5_new_features_spencer_05.png]
A 2-window view of a 3D Motion Project - just as you might see in Motion 4
There are a couple of nice new surprises to be found that I'll be reviewing in a later article.
While the interface change is the most obvious, it's not the most important - not by a long shot. Let's get right to the big stuff, starting with:
 
2) Final Cut Pro X Integration
While you have been able to bring Motion projects into Final Cut Pro for years, with Final Cut Pro X the way Motion and Final Cut Pro work together has been completely re-imagined. In Final Cut Pro X, you'll be using Motion projects without even realizing it - every time you add a title, transition, effect, or generator to your project!
To see what I mean, in Final Cut Pro X, take a look at the Browser buttons at the right side of the Toolbar.
[image: motion_5_new_features_spencer_06.jpg]
The Effects Browser in Final Cut Pro X. The icons to the right are, in order, the Photos Browser, Music/Sounds Browser, Transitions Browser, Titles Browser, Generators Browser, and Themes Browser.
Here we have collections of Effects, Transitions, Titles, and Generators - basically everything that you used to find in the Effects tab of the File Browser in Final Cut Pro 7 and earlier. There is a huge amount of content in here. And here's the kicker: right or control-click on any of these presets and you'll get a menu option to Open a Copy in Motion.
[image: motion_5_new_features_spencer_07.jpg]
Almost all elements in the effects, transitions, titles, and generators browsers are Motion projects - and can be modified in Motion.
That's right, virtually all of these these effects, transitions, titles, and generators are actually Motion projects! So whenever you add a lower third title to an interview clip, drop a transition on an edit point, give your footage a unique look with an effect, or add a background with a generator - you are adding a Motion project to your timeline.
This means that Motion has become much more than an optional motion graphics design application alongside the tools built into Final Cut Pro - it has became the development tool for creating effects for Final Cut Pro X. A fascinating new development with far-reaching implications.
Motion's integral role in Final Cut Pro X goes even deeper with two powerful new features. The first is:
 
3)Publishing
Publishing has two levels of meaning in Motion 5. The top level refers to the new ability to publish Motion projects (also called templates) to the appropriate browser in Final Cut Pro. In other words, when you create a new project in Motion 5, you first choose what type of Motion project you want to make. If you check out the new Project Browser that opens when you launch Motion (or start a new project), you'll see that in addition to the standard Motion project we've come to know and love, there are now 4 new project types - one for each of the browsers in Final Cut Pro: Effects, Generators, Transitions, and Titles.
[image: motion_5_new_features_spencer_08.png]
Motion 5's new Project Browser.
When you select and then save of these new project types, they are automatically published to Final Cut Pro and immediately available in the appropriate browser. That's all very exciting - but the second meaning of Publishing in Motion is where things get really interesting. In Final Cut Pro, if you apply an effect, transition, title, or generator to your project, and then take a look at the Inspector, you'll see some parameters you can adjust. In fact, if you use a Title, you'll see in the Title tab, that you'll see that they are called Published Parameters.
[image: motion_5_new_features_spencer_10.jpg]
Published Parameters in Final Cut Pro X's Title Inspector.
These are parameters directly from the Motion project that the designer chose to expose in Final Cut Pro. In other words, in addition to publishing the Motion title project as a whole so that it is available in Final Cut Pro, you can also choose what parameters of that project to publish to Final Cut Pro. Rather than forcing the Final Cut Pro user to go into Motion and pick from the potentially hundreds of different ways a project can be adjusted, you can choose just those parameters that are the most critical.
This ability to publish parameters is what makes using Motion projects in Final Cut Pro so incredibly flexible - right inside of Final Cut Pro X, the editor can make changes to the Motion project without ever launching Motion!
But it gets even better than that - thanks to the powerful new feature in Motion called...
 
4)Rigging
As opposed to publishing, which "connects" Motion 5 to Final Cut Pro X, rigging is a feature inside of Motion. However, publishing gives it immense power. So what is it? Essentially, rigging refers to the ability to tie multiple parameters together to single control.
For example, you can create a title that has several two animation options - perhaps the text fly on in different ways, and there are different background elements that animate - perhaps a quick, upbeat version; a slow, sedate version; and a few others. The animations may involve lots of keyframes and behaviors, text, shapes, particles - anything you can think of. You could "rig" each of these animations to a selection in a pop-up menu so that when you select it, only that animation plays.
Or, you could create a multiple, coordinated color themes for your project, where each theme changes the color of dozens of objects. Then, you could rig each set of colors to a single pop-up menu.
Or, you could create an effect, and rig all the different parameters that you used to create the effect - like filters, masks, and blend modes - to a single slider that adjusts all those parameter at the same time.
Or, you could have a simple checkbox that would turn on and off sets of layers and/or groups at the same time - revealing a completely different type of transition, for example.
[image: motion_5_new_features_spencer_11.png]
A Rig that includes two pop-up menus and a slider.
These single controls - pop-up menus, sliders, and checkboxes - that tie multiple parameters together are called Widgets. The widgets in Motion all live inside an object called a Rig. And the process of connecting parameters to a widget is called Rigging.
[image: motion_5_new_features_spencer_14.png]
Adding a Checkbox Widget to a new Rig.
[image: motion_5_new_features_spencer_15.png]
Revealing the Widget that the Hue parameter is rigged to. Note the small Joystick icon indicating that the parameter is rigged.
[image: motion_5_new_features_spencer_12.png]
A Rig that contains 5 pop-up menu widgets and two slider widgets. You can see a list all the parameters that are rigged to each Widget in the Rig Inspector on the left.
Now, the cool thing is - if this all weren't cool enough - that you can then publish these widgets to Final Cut Pro - so that the Final Cut Pro user will have access to the same pop-up menu, slider, or checkbox (named anything you like) that you used to control your project in Motion.
[image: motion_5_new_features_spencer_13a.png]
Pop-up Menu Widgets and a Slider Widget published and being used in Final Cut Pro X to change the color of all the elements in the project.
Rigging, when combined with publishing, allows you to create beautiful titles, transitions, effects, and generators that can then be modified in Final Cut Pro X in a myriad of ways. I can't wait to see all the inventive ways that folks figure out how to implement these great new features. They completely transform how Motion will be used, and they move Motion from an optional motion graphics tool to a center-stage development tool for creating any kind of effect for Final Cut Pro. And with the new technology underpinnings in Motion 5: 64-bit architecture, full color management, resolution independence, and full floating point rendering, Motion 5 will make it easier than ever to create beautiful motion graphics.
Which brings us to the last of the top 5:
 
5)Price
At only $49.99, Motion is an unbelievable bargain. While you can certainly use Final Cut Pro X without Motion, the fact that you can so easily modify existing preset effects and make your own with rigging and publishing make it a no-brainer purchase.
So you can see - the new Motion changes everything - yet Motion itself really hasn't changed at all. If you are already familiar with Motion 4, once you understand how to put rigging and publishing to work, you'll have no trouble creating your own incredible titles, transitions, effects, and generators for Final Cut Pro X. And if you've never used Motion before - you are probably going to want to start!
If you want to see more about Motion's new features, check out my preview movies for my two trainings - Motion 5 Fast Forward for folks new to Motion - and Rigging and Publishing in Motion - for folks comfortable with Motion 4 who what to get right into learning how to rig and publish their own titles, transitions, effects, and generators for Final Cut Pro X.
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Motion 5: Five Missing Features 
Apple giveth - and Apple taketh away
July 4, 2011     By Mark Spencer
 
Last week I wrote about some of the great new features in Motion 5: a sleek new user interface, deep integration with Final Cut Pro X, the ability to publish your own "Smart Templates" along with parameters you specify, a powerful new Rigging feature, and an unbelievable low price. There's also a fantastic new Keyer and a few other goodies that I'll be discussing in future articles.
[image: motion_5_missing_spencer_01.png]
 Motion 5's new interface - easy on the eyes, and everything still pretty much in the same place.
However, as folks are beginning to discover, Apple also removed some features in Motion 5 - features that many editors and motion graphics designers relied on as an integral part of their workflow.
If you are brand new to Motion, you probably won't notice anything missing. But if you've been using Motion 4 together with Final Cut Studio 7 and you are expecting everything to work the same - well, some things just won't. Specifically, here are what I consider the top five missing features in Motion 5 - and what the workarounds are.
 
1)Send To Motion Project and Round-tripping
By far the most glaring omission is the loss of the "Send to Motion Project" command that we could use to send one more more clips from Final Cut Pro 7 to Motion 4 in order to add motion graphics and visual effects. The Send To command not only automatically created a Motion project with the correct project settings that contained the selected clip(s), but also optionally embedded that Motion project into the Final Cut sequence so that any changes you might need to make could be accomplished by using the "Open in Editor" command: just change and save the Motion project, and it would automatically update in the Final Cut Pro timeline.
[image: motion_5_missing_spencer_02.jpg]
The Send to command in Final Cut Pro 7.
In Final Cut Pro X, the Send To command has vanished.
Now, it's true that in certain cases, sending clips from Final Cut Pro to Motion are no longer necessary. For example, you no longer to need to send clips to Motion in order to take advantage of Motion's Optical Flow retiming algorithm - Optical Flow is now built directly into Final Cut Pro X.
[image: motion_5_missing_spencer_03.jpg]
Selecting Optical Flow from the Retime menu in Final Cut Pro X.
Another reason for sending clips to Motion in Final Cut Pro 7 was to have a reference image for designing titles, such as lower thirds. But in Final Cut Pro X, you can do a great deal of design work directly within the application thanks to the Effects, Transitions, Titles, and Generators Browsers - they contain a ton of highly customizable presets. So you can design "in context" right inside of Final Cut Pro X.
But there are definitely times when you want to create your own title, transition, or effect from scratch - and it's helpful to be able to send the clips you want to use to Motion in order to do that. And, if you want to track a shot in order to add an image to scene, you have to do that in Motion - there's no way to do it in Final Cut Pro X.
Workaround: for these situations, what you'll need to do is the following: in Motion's File Browser, navigate to the Final Cut Event that contains the clip(s) you want to use, import them into your Motion project, and trim as needed. After you are done designing, you can either render out a movie, or you can publish your Motion project as a Generator - it will then be available in Final Cut Pro's Generator Browser, where you can drag it to your timeline to replace your clip(s). Neither of these solutions are elegant - but that's why they're called workarounds.
By the way, if you've installed FCP X and Motion 5 on the same partition as Final Cut 7 and Motion 4, when you choose Send to Motion from FCP 7, by default Motion 5 will launch - and the resulting project will not embed into the FCP 7 sequence. However, if you first launch Motion 4, so that it is running when you use the Send to command in FCP 7, the selected clip(s) get sent to Motion 4 and work as expected. See this support article from Apple for more information.
 
2)Video Output
Just as with Final Cut Pro X, there is no way to output your Motion 5 project to a professional calibrated monitor to check for broadcast-related issues such as interlace flicker, title and action safe, and color space issues. You could do this easily in Motion 4.
[image: motion_5_missing_spencer_04.png]
Video Output in Motion 4 - not currently available in Motion 5.
For me this is not a critical issue, since over the past few years my work has moved to almost 100% web delivery. But if you deliver for broadcast, especially in standard definition, the loss of this feature is painful.
Workaround: use the Safe Zones in the Canvas, use projects that are not interlaced as much as possible, and render and test your final output using Final Cut 7 to see it on a calibrated monitor.
 
3)Opening Multiple Project Files
In Motion 4, you could open as many project as you wanted: you could work on multiple projects at the same time, refer to other projects while designing, and copy layers and groups from one project to another. In Motion 5, you are restricted to opening just one project at a time: as soon as you double-click another project, choose File > Open, or choose File > New, the current project closes (Motion of course prompts you to save if necessary).
[image: motion_5_missing_spencer_05.jpg]
Motion 4, you could have several projects open at the same time.
Furthermore, you can no longer import entire Motion projects into another Motion project - a great workflow for building more complex motion graphics out of components.
Workaround: you can still save layers and groups by dragging them to the File Browser. You can close the project, open a new project, and drag those layers or groups into the new project. Not as easy as dragging between two open projects, but it works.
 
4)Rearranging the Workspace and Using Multiple Monitors
In Motion 4, the Utility Pane (File Browser, Library, and Inspector) was a separate window from the Canvas - so it could be moved to a second monitor, creating more room for the Canvas. You could also tear off any of the nine tabs and move them wherever you liked to customize your workspace.
[image: motion_5_missing_spencer_06.jpg]
The Layers tab in Motion 4, split off into its own window so that it can be moved anywhere - even onto a second monitor.
Motion 5's single window interface can't be split across multiple monitors - and "tabs" can't be moved at all.
Workaround: the F8 key still provides a full-frame Canvas view, just like in Motion 4 - but that's about it.
 
5)Performance
While I'm very excited that Motion 5 is now a 64-bit, fully color-managed application that works in float-space all the time (providing higher-quality renders) - I was really hoping for a performance boost. With the rewrite of the application and the introduction of new graphics cards (which Motion uses for most of its workload), it seemed reasonable to expect some really impressive gains. But I have found Motion 5's performance to be the same or worse compared to Motion 4. On a Mac Pro with a good graphics card like the ATI 5770, 4870, or 5870, performance is ok - but on my Mac Book Pro, just one generation behind the brand new Thunderbolt Macs, performance is much worse.
To be a fair comparison you would really need to run Motion 4 in 16-bit mode, since Motion 5 is 16-bit all the time. But the fact is that Motion 5 will at least appear to be slower than Motion 4 to most people.
Workaround: design more complex projects on a Mac Pro with a good graphics card.
In addition to these top five, there are several other features of Motion 4 that have disappeared in Motion 5:
      You can't preview Motion titles, transitions, effects, or generators in the Finder.
      You can no longer rename your .motn project to .mov in order to import it into After Effects
      Certain filters from Motion 4 have been removed, like Vectorize, Movement Blur, and Edgework.
[image: Screen shot 2011-07-09 at 2.18.32 PM.png]
The Finder view of a Motion 5 project on the left; a Motion 5 effect project on the right.
 
[image: motion_5_missing_spencer_09.png]
A few filters from Motion 4 are no longer available in Motion 5.
So while we have a great new interface on top of a completely rewritten 64-bit application with powerful rigging and publishing features, we've also lost several features - features that will be sorely missed by folks like me who have come to depend on them for our workflow. Some of these omissions, like roundtripping and external monitoring, I hope will get addressed in future updates. Others - like like the lack of Quicktime previews, after effects integration, and the ability to only open one project at a time - may well be part of the new world that is Motion 5 and Final Cut Pro X. Overall I'll take Motion 5 over Motion 4 any day of the week and twice on Sundays - but I do hope some of these missing features find their way back home.
If you want to learn more about using Motion 5, I have two in-depth tutorials available at Rippletraining.com
Motion 5 Fast Forward
Rigging and Publishing in Motion
copyright © Mark Spencer 2011
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